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Tutorial Outline

Time (est.) Module Outcomes Presenter

9:00-10:10 | 1. Overview of Eclipse + Introduction to PTP Greg

and PTP + Eclipse basics

+ Configuring Resource
Managers & setup

10:10-10:30 | 2. Creating and Running +PTP project creation

MPI Programs +New project wizards

+PTP Runtime Perspective

10:30-10:45 | Break

10:45-11:10 | 3. Parallel Language + MPI, OpenMP analysis
Development Tools (PLDT) features

11:10-11:45 | 4. Parallel Debugger + Debug Perspective,
breakpoints, variables,
stepping, etc.

11:45-12:15 | 5. Advanced Eclipse and + CVS, Makefiles, autoconf,
PTP features Search, Refactoring, UPC,
Remote debugging, MPICH2,
IBM PE & LoadlLeveler

12:15-12:30 | 6. Other, Summary, + Perf. tools, website, mailing
Wrapup lists, more info, participation
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Module 1: Overview of Eclipse
and PTP

+ Objective

+ To introduce the Eclipse platform and PTP
+ To learn the basics of Eclipse

+ Contents
+ What is Eclipse? Who is using Eclipse?
+ What is PTP?
+ Eclipse basics
+ Configuring a Resource Manager

Module 1 PTP Tutorial




paratiel-tools—platform
What is Eclipse?

+ A vendor-neutral open source development
platform

+ A universal platform for tool integration

+ Plug-in based framework to create, integrate
and utilize software tools

Java C/C++/Fortran Test and
Development Development Performance Parallel Tools
Tools Tools Tools

Platform

User

Module 1 PTP Tutorial
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Eclipse Platform

+ Core frameworks and services with which all
plug-in extensions are created

+ Represents the common facilities required by
most tool builders:
+ Workbench user interface
+ Project model for resource management
+ Portable user interface libraries (SWT and JFace)

+ Automatic resource delta management for
incremental compilers and builders

+ Language-independent debug infrastructure

+ Distributed multi-user versioned resource
management (CVS supported in base install)

+ Dynamic update/install service

Module 1 PTP Tutorial
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Plug-ins

Java Development Tools (JDT)

Plug-in Development Environment (PDE)
C/C++ Development Tools (CDT)

Parallel Tools Platform (PTP)

Fortran Development Tools (Photran)

Test and Performance Tools Platform (TPTP)
Business Intelligence and Reporting Tools (BIRT)
Web Tools Platform (WTP)

Data Tools Platform (DTP)

Device Software Development Platform (DSDP)
Many more...

+
+
+
+
+
+
+
+
+
+
+

PTP Tutorial
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Eclipse PTP: Parallel Tools Platform
http://eclipse.org/ptp

Coding & Analys

S Make - test.c - Eclipse SDK
Fie

Performance Tuning

Module 1

Launching & Monitoring
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ALLOGATED TO YOU EXCLUSIVELY, BUT DLE
ALLOCATED TO YOU SHARED, BUT IDLE

[
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STARTING
RUNING
EXITED NORMALLY

Current
Process Set

Process

View > 3

Source
View >

Debugging

PTP Tutorial
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Eclipse History

+ Originally developed by Object Technology
International (OTI) and purchased by IBM for
use by internal developers

+ Released to open-source community in 2001,
managed by consortium
+ Eclipse Public License (EPL)
+ Based on IBM Common Public License (CPL)

+ Consortium reorganized into independent not-
for-profit corporation, the Eclipse Foundation,
in early 2004

+ Participants from over 100 companies

Module 1 PTP Tutorial
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Eclipse Foundation & Members

+ Board of Directors and full-time Eclipse
management organization

+ Councils guide the development done by Eclipse
Open Source projects

+ 180 members (March '08)
+ 21 strategic members

+ 942 committers, representing 50+ organizations
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Eclipse Member companies

Eclipse Membership through March 2008
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Parallel Tools Platform (PTP)

+ The Parallel Tools Platform aims to provide a highly
integrated environment specifically designed for parallel
application development

+ Features include:

+ An integrated development environment (IDE) that

supports a wide range of parallel architectures and runtime
systems =

+ A scalable parallel debugger

+ Parallel programming tools
(MPI/OpenMP)

+ Support for the integration
of parallel tools

+ An environment that simplifies the
end-user interaction with parallel systems

+ http://www.eclipse.org/ptp

Module 1 PTP Tutorial
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PTP
Software Prerequisites

+ Java (1.5 or later)
+ Cygwin or MinGW (for Windows)

+ make, gcc, and gdb (or other vendor
compilers)

+ OpenMPI or MPICH2 (only required for PTP
Runtime)

Note:
+ Linux & Mac have full PTP support

+ Windows can be used for Eclipse, targeting a
remote parallel machine

Module 1 PTP Tutorial
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Java Prerequisite

+ Eclipse requires Sun or IBM versions of Java
+ Only need Java runtime environment (JRE)
+ Java 1.5 is the same as JRE 5.0

+ The GNU Java Compiler (GCJ), which comes standard
on Linux, will not work!

Module 1 PTP Tutorial
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Eclipse and PTP Installation

+ Eclipse is installed in two steps

+ First, the ‘base’ Eclipse is downloaded and installed
+ This provides a number of pre-configured ‘features’

+ Additional functionality is obtained by adding more
‘features’

+ This can be done via an "update site’ that
automatically downloads and installs the features

+ Features can also be downloaded and manually
installed

+ PTP requires the following features
+ C/C++ Development Tools (CDT)
+ Parallel Tools Platform (PTP)

Module 1 PTP Tutorial
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Eclipse Installation

+ Two alternatives for installation:

+ The Eclipse Classic is the full software development kit
(SDK), including Java and Plug-in development tools

+ The Eclipse IDE for C/C++ developers is the base Eclipse
platform plus the CDT (C/C++ Development tools).
This is ideal for PTP use (included on the tutorial CD)

+ Eclipse is downloaded as a single zip or gzipped tar file
from http://eclipse.org/downloads

+ You must have the correct file for your operating system
and windowing system

+ Unzipping or untarring this file creates a directory
containing the main executable

Module 1 PTP Tutorial




paratel—toois—platiform

Platform Differences

+ Single button mouse (e.g. MacBook)
+ Use Control-click for right mouse / context menu

+ Context-sensitive help key differences
+ Windows: use F1 key
+ Linux: use Shift-F1 keys

+ MacOS X

+ Full keyboard, use Help key

+ MacBooks or aluminum keyboard, create a key binding
for Dynamic Help to any key you want

+ Accessing preferences
+ Windows & Linux: Window » Preferences...
+ MacOS X: Eclipse»Preferences...

Module 1 PTP Tutorial




parateltoois—pilat

Starting Eclipse

+ Linux
+ From a terminal window, enter

<eclipse installation>/eclipse/eclipse &

+ MacOS X
+ From finder, open the Applications» eclipse folder
+ Double-click on the Eclipse application
+ Windows
+ Open the eclipse folder
+ Double-click on the eclipse executable

+ Accept default workspace when asked
+ Select workbench icon from welcome page @

Module 1 PTP Tutorial
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Specifying A Workspace

+ Eclipse prompts for a workspace location at
startup time

+ The workspace contains all user-defined data
+ Projects and resources such as folders and files

[v) Workspace Launcher
Select a workspace

Eclipse SDK stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

The prompt can be

tu rnEd Off Workspace: | /home/tutnn/workspace

[] Use this as the default and do not ask again

Module 1 PTP Tutorial
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L™

Eclipse Welcome Page =

+ Displayed when Eclipse is run for the first time

Java - Eclipse SDK

Module 1 PTP Tutorial
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Adding Features

+ New functionality is added to Eclipse using features
+ Features are obtained and installed from an update site
(like a web site)

+ Features can also be installed manually by copying files
to the features and plugins directories in the main

eclipse directory

Module 1 PTP Tutorial
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Installing Eclipse Features
from an Update Site

+ Three types of update sites

+ Remote - download and install from remote server
+ Local - install from local directory

+ Archived - a local site packaged as a zip or jar file

+ Eclipse 3.3.2 comes preconfigured with a link to the
Europa Discovery Site

+ This is a remote site that contains a large number of official
features

+ Europa projects are guaranteed to work with Eclipse 3.3.2

+ Many other sites offer Eclipse features
+ Use at own risk

Module 1 PTP Tutorial
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=

Installing from a Local Update Site

& Install

We have combined everything needed | ="
for the tutonal Onto a Iocal update S|te Select update sites to visit while looking for new features.
on the CDROM

Sites to include in search:

From the HElp menu, ChOOSE [ <] Europa Discovery Site

Software Updates»Find and 0 4l The Eclipse Project Updates " New Localsite... |
I nSta I I - | New Archived Site...|

Select Search for new features to
install

Click Next > -
Click New Local Site... | mportsices..._|

NaVigate to your CDROM, select the | Exportsites... |

updatesite folder and click Choose
(OK on Linux or Windows) 2 lgnore feat| NS

Enter Tutorial for the Name ag: (Tutoria

(Or use default: TutoriaICD/ . |file:/media/cdrom/updatesite/ |
updatesite)

Click OK ® @ | | cancel |

Module 1 PTP Tutorial
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Installing Tutorial Features

+ Make sure only Tutorial S~ Bl
is selected, other options Search Results
as defaUItS Select features to install from the search result list. ) -

+ CI ICk FI n ISh Select the features to install:

+ From Search Results, » @ 4 Tutorial Deselect All |

select Tutorial (open
the twisty to see the
CoO ntentS) Select Required |

1 of 1 selected.
Show the latest version of a feature only

[] Filter features included in other features on the list

Cancel

Module 1 PTP Tutorial
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Choose features

Select features to install from the search result list.

Select the features to install:

+ Choose PTP features to 07 Virmeormonsos | | S22
install

+ Easy way to choose:
Select the features to install:
+ Se I eCt a I I < [ 4| ptp-updatesite-2.0.0.200803280847.zip

- _‘Parallel Tools Platform 2.0
+ U n Se I eCt a n yth I n g . Parallel Tools Platform End-User Runtime 2.0.0.200803280847
H A\ 144
with red “X

TP Parallel Language Development Tools 2.0.0.200803280847
+ This omits features

: PTP Common External Components 2.0.0.200803280847
: PTP Remote Tools Enabler 2.0.0.200803280847

for which you lack

the pre-requisites

» 00 Parallel Tools Platform 2.0 More Info

Properties

( Select Required

: PTP RSE Enabler 2.0.0.200803280847
- PTP Remote Tools 2.0.0.200803280847
: PTP Support For IBM LoadlLeveler 2.0.0.200803280847
TP Support For IBM Parallel Environment 2.0.0.200803280847
TP Support For Open MPI1 2.0.0.200803280847
TP Scalable Debug Manager 2.0.0.200803280847
TP Support For MPICH2 2.0.0.200803280847
TP Performance Analysis Framework 1.0.0.200803280847
TP Remote Development Tools 1.0.0.200803280847
TP Performance Analysis Framework for TAU 1.0.0.200803280847
: PTP Performance Analysis Framework: TAU Fortran Enabler 1.0.0.200803280847
PTP Parallel Language Development Tools - LAPI support 2.0.0.200803280847

|
|
|
|
|
|
|
oy
0y
|
|
|
|
O
|
|
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Finishing Installation

CIICk NeXt > Search Results

Acce pt the Iicense terms Select features to install from the search result list.

CIICk NeXt > Select the features to install:

CIle FiniSh » @ “ Tutorial Deselect All |

For Feature Verification, click
Install All

Restart the Eclipse Platform when Select Required|
asked

It is recommended you restart the Eclipse Platform for the
changes to take effect, but it may be possible to apply the
changes to the current configuration without restarting. Would
you like to restart now?

N Apply Changes @ ’ ' ' Cancel

Module 1 PTP Tutorial
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Restarting Eclipse

C/C++ - Eclipse Platform - fhome/beth/ecl/cpp0402/eclipse/~/ews/temp0402a EE=
Fle Edit Refactor Navigate Search Project Run Window Help

+ Welcome page [FREESE -
informs you of o) & :- k
new features Go to
installed '
o Overview workbench
WO rkben Ch |CO n The Eclipse Platform is a kind of universal tool platform - an open extensible IDE for anything and nothing in particular.

tO gO tO | Parallel Tools Platform

WO rkben Ch Leamn more about PTP, the Parallel Tools
Platform. Ye | |OW

indicates new
| _ features just
Learn more about PLDT, to help in developing
MP! and OpenMP programs. |n Sta I |ed

e

Parallel Language Development Tools

Workbench basics

Learn about basic Eclipse workbench concepts

Module 1 PTP Tutorial
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(Installing the PTP Proxy)

+ Normally installed on a parallel machine
+ e.g. a cluster
+ Can install on a non-parallel system

+ Not available for Windows

+ Requires OpenMPI to be built and installed
+ This process depends on the type of machine
+ Beyond the scope of this tutorial

+ To install the proxy, do the following steps from a terminal
+ Change to your Eclipse installation directory

+ Change to plugins/org.eclipse.ptp.os. arch 2. 0, where
os is your operating system (macosx Or 1inux), arch iS your
architecture (ppc, x86, or x86 64)

+ Run the command: sh BUILD
* Directory may include a suffix of build date timestamp.

Module 1 PTP Tutorial 1-25
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Workbench

+ The Workbench represents Resource " Exlipsa SO

th e d eS kto p d eve | O p m e nt Eiilev Edit Aﬂ.avigate 7Segrch Er?'ect h&un]. Window :Eﬂelp —

L5 Project Explorer &3 =8

+ It contains a set of tools
for resource management

+ It provides a common Pakesi . B Comadl & X % 7 =0

way of navigating through 0items

th e reSO U rCGS An outline is not available. :

+ Multiple workbenches can
be opened at the same
time

Module 1 PTP Tutorial
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Workbench Components

+ A Workbench contains perspectives
+ A Perspective contains views and editors

Resource - MyCproject/src/MyCproject.c - Eclipse SDK
Edit Refactor Navigate Search Project Run Window Help

pe rS peCtlve ' Project Explorer &3 Ll MyCproject.c &

L =
= #include <stdio.h>

~ =% MyCproject #include <stdlib.h>

edltor ’ - - int main(void) {
h puts("!!!Hello World!!!"); prints !!!
return EXIT_SUCCESS;

}
Ll =~ ] [>]

v: Tasks &2  [El Console 3 % % v =08

I [Ty

1 stdio.h

P (= Debug

o= Outline £2

0.
® maintvaid) : int E]
oe

Module 1 PTP Tutorial




paratel—toois—platiform

Perspectives

+ Perspectives define the layout of views in the
Workbench

+ They are task oriented, i.e. they contain
specific views for doing certain tasks:

+ There is a Resource Perspective for manipulating
resources

+ C/C++ Perspective for manipulating compiled code
+ Debug Perspective for debugging applications

+ You can easily switch between perspectives

Module 1 PTP Tutorial
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Switching Perspectives

4+ You can switch

Resource - MyCproject/src/MyCproject.c - Eclipse SDK

\
Pe rS pectives by : Ei:le Edlt Arlefaocior !ulavigat% Sjgrd; %rcfjject | gurl Window Help
+ Choosing the

Window»Open e
Perspective menu ™ oot
Option > r. Include puts("!!!Hello World!!!"); prints !!! I:|

return EXIT_SUCCESS;
+ Clicking on the
Open Perspective 7Tasks 8 Console

5% Outline 2 =8 0 items
button TR T S [
5 o = stdio.h
+ Clicking on a

= stdlib.h
perspective shortcut e
button o

Resource

Module 1 PTP Tutorial
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Available Perspectives

Window »

+ By dEfaUIt, Certa|n Open Perspective

perspectives are available TR ETE—

in the Workbench » |
+ We,” Use . CVS Repository Exploring

% Debug
+ C/C+ + 7 PTP Debug
+ PTP Ru ntime 888 PTP Runtime
[y Resource
+ PTP Debug

£Y Team Synchronizing

|. OK -| |. Cancel .|

Module 1 PTP Tutorial
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Resource - MyCproject/src/MyCproject.c - Eclipse SDK. ﬁ
File Edit Refactor Navigate Search Proj R ind Help

Views

+ The workbench window is
divided up into Views

+ The main purpose of a view is:
+ To provide alternative ways of presenting information
+ For navigation
+ For editing and modifying information

+ Views can have their own menus and toolbars

+ Items available in menus and toolbars are
available only in that view

+ Menu actions only
I o= i d R S o ¥
apply to the view of Outline [CENR "

+ Views can be resized ¢ main():int

Module 1 PTP Tutorial
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Stacked Views

+ Stacked views appear as tabs

+ Selecting a tab brings that view to the
foreground

Resource - MyCproject/src/MyCproject.c - Eclipse SDK
dit Refactor Navigate Search Project Run Window Help

Ty [\ Resource

= 0|l [g MyCproject.c &2
#include <stdio.h>
¥ =5 MyCproject #include <stdlib.h>
T
b % Binaries int main(void) {
b = Includes puts("!!!Hello World!!!"); prints !!!
v (Esrc return EXIT_SUCCESS;

D lel [+]
P (= Debug = [2]
. +:\ v =28

S o ~ S
ANN o T [ fomomm [wesme |F

5% Outline 52

= stdio.h
= stdlib.h

® main(void) : int 3 2 [*]
= :HJ

Module 1 PTP Tutorial




Access help
+ Help»Help Contents
+ Help»Search
+ Help»Dynamic Help

Help Contents provides
detailed help on different
Eclipse features

Search allows you to

search for help locally, or
using Google or the Eclipse
web site

Dynamic Help shows help

related to the current
context (perspective, view,
etc.)

Module 1
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Help

Search:

Contents

> Workbench User Guide
> Java Development User Guide

Help - Eclipse SDK
Search scope: All topics

—

[(? )2 )

> Platform Plug-in Developer Guid

> JDT Plug-in Developer Guide

Using the Eclipse help system

** Plug-in Development Environme

> PTP: Parallel Tools Platform
“> PTP Parallel Language Developr
> CDT Plug-in Developer Guide

Browse topics in the Contents frame (/) on
the left. Click on a topic to have it displayed.
Use the Back and Forward buttons to
navigate within the history of viewed topics.

> C/C++ Development User Guide

PTP Tutorial

Searching

To quickly locate topics on a particular

subject in the documentation, enter a query in

the Search field. Use the Search frame (") to
display the Search view. You can narrow the
scope of your search by selecting only the
sections you are interested in. ~]

[>]
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—_—

_
v 22\

—

Open PTP Runtime Perspective

Window > Open Perspective > Other...
uew Window

en Perspective | %5 Debug

Show View » & Team Synchronizing
=iz CVS Repository Exp
Customize Perspective... Other... %> Debug

Save Perspective As... \ 7% PTP Debug

Reset Perspective 858 PTP Runtime\
Close Perspective .5 Resource

Close All Perspectives &Y Team Synchronizing
Navigation

Working Sets
Preferences...

Module 1 PTP Tutorial
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Terminology

+ The PTP Runtime perspective is provided for
monitoring and controlling applications

+ Some terminology

+ Resource manager - Corresponds to an instance of
a resource management system (e.g. a job
scheduler). You can have multiple resource mangers
connected to different machines.

+ Queue - A queue of pending jobs

+ Job - A parallel application

+ Machine - A parallel computer system

+ Node - Some form of computational resource

+ Process - An execution unit (may be multiple
threads of execution)

Module 1 PTP Tutorial
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PTP Runtime Perspective

Resource
managers view

Machines view

Node details
view

Jobs view

Module 1

& PTP Runtime - mpitest/mpitest.c - Eclipse SDK
File Edit Refactor Navigate Search Project Run Window Help

i) W | By Oy Qv ]

(¥) Resource Managers &3 =g

&3 Machines 2 =08
Please select a machine

Node Attributes Process Info
Attribute Value

g8 Jobs 3 =0
Please select a job
[

PTP Tutorial

{ |88 PTP Runti... [EC/C++

[ mpitest.c &

#include <mpi.h>
#include <stdio.h>

int
main(int argc, char *argv[])
{

int rank;

MPI_Init(&argc, &argv);
MPI_Comm_rank (MPI_COMM_WORLD, &rank);
printf("hi from %d\n", rank);
MPI_Finalize();

exit(0);

El Console 2 - [Z. Problems [ Properties v Tasks €] Error Log

No consoles to display at this time.
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Resource Managers

+ PTP uses the term resource manager to refer to any
subsystem that controls the resources required for
launching a parallel job.

+ Examples:

+ Job scheduler (e.g. LoadlLeveler)
+ Open MPI Runtime Environment (ORTE)

+ Each resource manager controls one target system
+ Resource Managers can be local or remote

Module 1 PTP Tutorial
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Adding a Resource Manager

+ Right-click in Resource
Managers view and select

Add Resource Manager

+ Choose the ORTE
Resource Manager

Type

+ Select Next>

Module 1

File Edit Refactor Navigate Search Project Run Window Help

v 5 'f;;v LAV Qv

() Resource Managers £

Add Resource Manager...

588 Machines 22

Choose Resource Manager Type

Select the type of resource manager to use

Resource Manager Types:

LSF
MPICH2

ORTE

PTP Tutorial




parateltoois—pilat

Configure the Resource Manager

ORTE Proxy Configuration + Ca n C_ZhOOSG R_emOte
Enter information to connect to an ORTE proxy server service pI‘OVIdeI‘

- / + Can choose Proxy
Remote service provider: | Local o server |Ocati0n

Proxy server location: Local ¢

Path to proxy executable: |‘847/bin/ptp_orte_proxy|'| Browse Options...

Multiplexing Options

@ None Choose Resource Manager Name and Description

Local address for proxy connection: |localhost.localdomain v Enter a name and description for the resource manager

_ [] Use default name and description:

ORTED Configuration

[] Launch server manuall : ‘
- Enter information to configure ORTED GRS ORTE@Local

Description: |ORTE Resource Manager

V] Use default settings

Path to ORTED:

Extra ORTED arguments:

. inish
For details on remote Finis

resource managers, see
Module 5 Finish Cancel

Module 1 PTP Tutorial




+ Right click on new
resource manager and

select Start resource
NELEL[E

If everything is ok, you
should see the resource
manager change to green

If something goes wrong,
it will change to

(») Resgfirce Managers 23

(@ ORTE@N.N.N.N (ORTE)

Module 1

Add Resource Manager...

Remove Resource Manager
Edit Resource Manager

888 Machines 23 P> Start Resource Manager
Please select a mac

w Resource Managers 23

P (@ ORTE@N.N.N.N (ORTE)

PTP Tutorial




Machine status shown in
Machines view

Node status also shown
Machines view

Hover over node to see
node name

Double-click on node to
show attributes

Module 1

858 Machines £3 =X {rv

N ORTE@N.N.N.N: localhost.localdomain - Root [64]

0 I [

O [y Il () iy o ) ) I
20 juy oy oy o [ ) ) i B
30 [ (o ) ) ) i e B
40 [l [l Iy o ) I I S i B
SO [ (e () D) ) ) I e B
60 By I B B

Node Attributes Process Info
Attribute

| Node Number 0
Node State UP

PTP Tutorial
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Module 2: Creating and
Running MPI Programs

+ Objective

+ Learn how to use Eclipse to develop parallel programs
+ Learn how to run and monitor a parallel program

4+ Contents
+ Brief introduction to the C/C++ Development Tools
+ Create a simple application

+ Learn to launch a parallel job and view it via the PTP
Runtime Perspective

Module 2 PTP Tutorial
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Switch to C/C++ Perspective

Window BalEle

+ Only HGEdEd |f New Window

you're not
a I ready |n the CVS Repository Exploring

. Show View » | o Resource
perspective

Customize Perspective... Other...
Save Perspective As...
Reset Perspective

Close Perspective
Close All Perspectives

Navigation ' CV5S Repository Exploring
= %F Debug
~ Working Sets ¥ PTP Debug
Preferences... g5 PTP Runtime
[’ Resource

&Y Team Synchronizing

[ oK || cancel |

Module 2 PTP Tutorial
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Project Explorer View

+ Represents user’s data

+ It is a set of user defined
resources [ Project Explorer &3 =08
M
+ FOlderS b 3% Binaries
+ PI‘OjeCtS P mYIncludes

¥ (Hsrc
+ Collections of files and b [2 MyCproject.c
folders P (= Debug

4+ Plus meta-data

4+ Resources are visible in
the Project Explorer View

Module 2 PTP Tutorial
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Editors

Resource - MyC| ject.c - Eclipse SDK.
File Edit Refactc Navigate Search P R

An editor for a resource (e.g. a file)
opens when you double-click on
a resource

The type of editor depends on the type of the resource
+ .c files are opened with the C/C++ editor
+ Some editors do not just edit text

When an editor opens on a resource, it stays open across
different perspectives

An active editor contains menus and toolbars specific to that
editor

When you change a resource, an asterisk on the editor’s title
bar indicates unsaved changes

.c| *MyCproject.c &3

Module 2 PTP Tutorial




Source

A source code editor is a
special type of editor for
manipulating source
code

Language features are
highlighted
Marker bars for showing
+ Breakpoints

+ Errors/warnings

+ Tasks

Location bar for
navigating to interesting
features

Module 2
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Code Editors

¢« linear_function.c &3
I 4
¥ Returns f(x) = 3.0%x + 2.€C
7
double evaluate(double x)

{
v // add semicolon to end of next line
double y = 3.0*%x + 2.0
& ...returny;

5}

PTP Tutorial
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Set up for MPI development =
Preferences

+ To use the PTP Parallel Language Development Tools feature for
MPI development, you need to _
+ Specify the MPI include path I et
+ Specify the MPI build command  [fie- ————

P Ant

+ Open b Crces
P> Help

Window » Preferences... b InstallUpdate
+ Open the PTP item I

P Plug-in Development

+ O pe n th e Pa I"a I Iel La ng u age v szarallel Language Dev MPI build command: | mpicc
Development Tools item
OpenMP

* SG'ECt MPI Resource Managers

+ Select New... to add MPI ) Rovbong
include path

+ If running OpenMP, add its
include file location here too )

fusr/localfinclude

(we will cover that later)

Module 2 PTP Tutorial
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Creating a Parallel Application

Steps:

+ Create a new C project
+ Edit source code

+ Save and build

Module 2 PTP Tutorial
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Creating a simple =1
MPI Project (1)

Create a new MPI project
. - | C Project
+ FI Ie > N ew > C P rOJ ect Create C project of selected type

+ N a m e th e p rOj eCt Project name: |MyHelloProject|
\ M y H e | I O P roj ect 4 ¥ Use default location

+ Under Project types, under e
Executable, select MPI

@ Hello World C++ Project

Hello World C Project @ Hello World ANSI C Project

® Empty Project
d h . N 2 MPI Hello World C Project
and hit Next © MPI PIC project
@ MPI Pi C++ Project

On BaSiC Settings pagel ® MPI Empty C Project
fl” |n informatlon for your @ OpenMP Hello World C Project

® OpenMP Empty C Project

new project (Author
name etc.) and hit Next

| Show project types a oolchains only if they are supported on the platform

Next > [ Finish ‘ Cancel

Module 2 PTP Tutorial
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Creating a simple
MPI Project (2)

On the MPI Project Settings P! Project Settings
lea I‘C| pag e, ma ke sure Add Select the _MPI inc!ude path, lib name, library search path, and bui!d
M PI pI‘OjeCt Setti ngs to th iS command information to be automatically be added to the new project.

project is checked.

w| Use default information

Change defaUIt pathS, EtC. If Include path fust/localfinclude
necessa ry (they are pI"Obably Library name: mpi

O K) Library search path fusr/local/lib
H |t Fi n i Sh %k . MPI compile command: |mpicc

MPI link command
*If you instead hit Next, then

on the Select Configurations
page, you can alter Project

settings. Hit Finish.

Module 2 PTP Tutorial
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Changing the C/C++ Build =9
Settings Manually

Open the project properties

by right-mouse clicking on

project and select

Properties |

Open C/C++ Build s BT corvmenc: (e )

(%% Preprocessor All options: -lfusr/localfinclude -00 -g3 -

Select Settings e || Eom
Z ++ Genera e.s
z on

Select GCC C Compiler to
change compiler settings

Select GCC C Linker to ;
change linker settings sy et |

v & GCC Assembler

It's also possible to change » " e
compiler/linker arguments T T

ype filter text/il Settings

Configuration: | Debug

Run/Debug Settings

Module 2 PTP Tutorial
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Fle Edit Refactor Navigate Search Project Run Window Help

+ Double-click on ol E e o e G | & 8 |5 0w B G O - e
source file in the ® 4 : D
PrOjeCt EXPlorer g Y #include <stdio.h> A
to Open C ed itor ¥ 1 MyHelloProject :i:&:::: " rm::ui.i:::?'h:' stdio.h

string.h

[¢ MyHelloProject.c i3 g=out B @ mak = O

int main({int argc, char* argv[]){ -
int my_rank; /* ran F mpi.h
nt p; /* number of paeeeetts & main(int, char*{]) : i

+ Outline view is MyHeﬂaniect.c [ sl

I» = Debug int tag:EI_:

Shcwn f0r flle In char m ssage[lé--

editor R o

[Z Problems &3 v Tasks | &l Console = Properties [ Remote Environm = B

0 errors, 0 warnings, 0 infos

Description Resource Path Location

Writable sm..rt

Module 2 PTP Tutorial




Content Assist

+ Type an incomplete MPI function name e.g. "MPI_Ini" into the
editor, and hit ctrl-space

+ Select desired completion value with cursor or mouse

MPI_Inil

@ MPL_Init(int *, char ***) int Initializes MPI.
/7 IiRG @ MPL_Init_thread(int *, char ***, int, int *)int
MPI_Com @ MPI_Initialized(int *) int

+ Hover over the MPI Artifact B

find out process rank

identified in the source file to i-(PI_Co!nm_ _ ank (l-il;i_&ox-n-i_{-}ORiD, &my_rank) ;
See d d d Itl ona I I n fo Fma tl on gfﬂ:éy;i?iin&n;ﬂa‘;m_rank(MPI_Comm, int *)
Description:

a bo u t th d t fu n Ctl on Ca I I / fo r Returns the rank of the local task in the group associated with a comrrjuhicgtor.
example Press 2 for focis.

Module 2 PTP Tutorial
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Context Sensitive Help

Click mouse, then press help
key when the cursor is within a
function name

+ Windows: F1 key

+ Linux: ctrl-F1 key

+ MacOS X: Help key or

Help» Dynamic Help Related Topics
v About

A help view appears (Related Cick below to see help.
Topics) which shows S L

. i - (2 Editor view CHCK hel®
additional information B it WP1 Comm_r P Comm. nt
Click on the function name to s
see more information fol=2 2

Move the help view within your
Eclipse workbench, if you like, MPI_Comm_rank
by dragging its title tab

¢ @l ¢

int MPI Comm vark (MPI Comm, int *)

Retums the rank of the local
task in the group associated
with a communicator.

Module 2 PTP Tutorial
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Running a Parallel Application

Steps:
+ Create a launch configuration
+ Run the application

+ Monitor its progress in the PTP Runtime
Perspective

Module 2 PTP Tutorial
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o L

Create a Launch Configuration

Create, manage, and run configurations

o e Wil IV e

— -~ Create a configuration to launch a parallel application in Parallel Perspective
Organize Favorites...

Configure launch settings from this dialog:
ype filter text - Press the 'New' button to create a configuration of the selected type.

5] C/C++ Local Application - Press the 'Duplicate’ button to copy the selected configuration.

* O pen the run : Parallel Application ¥ - Press the 'Delete' button to remove the selected configuration.

)

. . +» - Press the 'Filter' button to configure filtering options.
configuration

. - Edit or view an existing configuration by selecting it.
dialog Run»
0 pe n Ru n D|a |Og nnn Configure launch perspective settings from the | reference

page.
Select Parallel
Application Filter matched 2 of 2 items

Select the New
button

Module 2 PTP Tutorial
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Complete the Resources Tab

+ In Resources tab, select
the resource manager you
want to use to launch this

job
+ Enter a value in the
Number of Processes field

Module 2

Create, manage, and run configurations

Create a configuration to launch a parallel application in Parallel Perspective

Name:  MyHelloProject

cation | %> Debugger| 9= Arguments | & Source | B§ Environment ”-|

<,

1 Resources

pplication | gacoiree Manager: | ORTE@Local

+ &5 Parallel Application

Launch Attributes

Number of Processes:

B Apply Revert

Filter matched 3 of 3 items

Run

PTP Tutorial




paratel-tools—platform

_——

=\
w53\

Complete the Application Tab

+ Ensure that the correct crente, maege, o omfrion
Parallel Project is selected R —

+ Select the Application ] | e
program (executable) by p—
clicking the Browse button E e
+ Local program: executable nome ethjews MyWorkspace/yHeloProject/DebugMyHeloproject || Browse
is under Debug folder in the
project
+ Remote program: must
copy to remote machine;
navigate to its location on
the remote machine here.

S e | e Ct D i S p I a y Filter matched 3 of 3items

combined output in a
console view if desired

>

Module 2 PTP Tutorial
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w52\

Complete the Debugger Tab

S e I eCt De b u g g e r ta b Create, manage, and run configurations

C h Oose S D M fro m th e Create a configuration to launch a parallel application in Parallel Perspective
Debugger dropdown

Confl rm the debugger V +_I_:aIA;;I|af|cr1

~ &% Parallel Application

executable
Set debugger session

= Arguments - Source | F§ Environment ”1

a d d ress :n: st Iipse.ptp.Iinux..x.85_2.D.D.ZDDBD429‘222!21,'1:nin,"5dm” Browse

In Arguments ta b’ enter [localhost.localdomain
arguments and working
directory

Click on Run to launch the
program

Apply Revert

Run Close
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Viewing The Run

File Edit Refactor Navigate Search Project Run Window Help

+ DOUbIe'C“Ck d v @ | %y Ov & @ O | |4 S & |#8PTP Runti...| EIC/C++
(%) Resource Managers 3 = 0O | [ MyHelloProject.c &2

nOde In I I laCh I nes P (@ ORTE@Local (ORTE) int main(int argc, char* argv

H = int my_rank; /* rank of |
view to see which It sharces [+ ronee e
int dest; f

processes ran on ] char message[160];

ORTE@Local: localhost./®miggmai MPI_Status status ; ¥ return

the nOde & localhost localdomain gqalelelal TTIlIl L et up L

MPI_Init(&argc, &argv);

* find out pro rank *
MPI_Comm_rank (MPI_COMM_WORLD, &my_rank);

Hover Over a Node Attributes Plocess Info l’lgliégmm_!;z[e“é‘r";}DIV_COIEIMi_\J-IORLD, &p);

process for tooltip ¥ ponz

Name node0
O u Node Numt 0
p p p Node State UP
[>]
= - E Console 82  [2. Problems [ Properties < Tasks
C-Build [MyHelloProject]

Job and processes - 2 et —

mpicc -L/usr/local/lib -o"MyHelloProject" ./src/
MyHelloProject.o  -lmpi

s h OW n I n JO bs Finished building target: MyHelloProject
View

Module 2 PTP Tutorial
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Viewing Program Output

File Edit Navigate Search Project Run Window Help
w | Y Ov v @~ (O | E | 5 > < & |88 PTP Runti...| f&C/C++

(3 Resource Managers 2 = 8 [¢ MyHelloProject.c 832 job02:0 2

b @ ORTE@Local (ORTE) Process details

PID: 23513
Status: EXITED

~ Program output
828 Machines &2 \ :

= Hello MP1 World From process 0: Num processes: 4
ORTE@Local: localhost.localdomain - Root [10] Hello MPI World from process 1!

&= localhost.localdomain AN EEEEEE | Hello MP1 World from process 2!
H Hello MP1 World from process 3!
+ Double-click a

process to see
process detail and
Standa rd Output Node Attributes Process Info

Attribute Value + job02:1

from the process

Node Numt 1
Node State UP

88 Jobs 4|7 0 ‘B console 52 [2 Problems| = Properties| & Tasks
ORTE@Local: defd® C-Build [MyHelloProject] S B |
o LI ) .
=/jobg2 Invoking: GCC C Linker
mpicc -L/usr/local/lib -o0"MyHelloProject" ./src/
MyHelloProject.o  -lmpi
Finished building target: MyHelloProject

EXITED PID: 23513
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+ Open using legend icon in

toolbar

Module 2

paratel-—toois—platform

About PTP Icons

—

-

Resource Manager Icons

@ STARTING
(@ STARTED

STOPPING
., STOPPED
., SUSPENDED
@ ERROR

Machine Icons
UpP
DOWN
ALERT
ERROR
UNKNOWN

Job Icons
PENDING
STARTED
RUNNING
TERMINATED
SUSPENDED
ERROR
UNKNOWN

PTP Tutorial

Node Icons

L
L
(X

?

=~

up

DOWN

ERROR
UNKNOWN
USER EXCLUSIVE

Process Icons

>

STARTING

RUNNING

EXITED NORMALLY
EXITED WITH SIGNAL
SUSPENDED

ERROR

UNKNOWN

USER SHARED

OTHER EXCLUSIVE
OTHER SHARED
PROCESS RUNNING
PROCESS TERMINATED

\:'.\\
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Module 3: PTP and Parallel
Language Development Tools

+ Objective

+ Learn to develop a parallel program
+ Learn to analyse with PLDT

4+ Contents

+ Learn to use PTP’s Parallel Language Development
Tools

+ Learn to find MPI & OpenMP artifacts
+ Learn how to do MPI and OpenMP Specific analysis

PTP Tutorial
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Parallel Language Development
Tools (1)

4+ Features

+ Analysis of C and C++ code to determine the location
of MPI and OpenMP Artifacts (Fortran planned)

+ "Artifact View" indicates locations of Artifacts found in
source code

+ Navigation to source code location of artifacts
+ Content assist via ctrl+space ("completion™)
+ Hover help

+ Reference information about the MPI and OpenMP calls
via Dynamic Help

PTP Tutorial
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Parallel Language Development
Tools (2)

+ More PLDT features:

+ New project wizard automatically configures
managed build projects for MPI & OpenMP

+ OpenMP problems view of common errors

+ OpenMP “show #pragma region” action

+ OpenMP “show concurrency” action

+ MPI Barrier analysis - detects potential deadlocks

PTP Tutorial
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Show MPI Artifacts

Select source file; Run
analysis by clicking on
drop-down menu next
to the analysis button
and selecting Show
MPI Artifacts

Markers indicate the
location of artifacts in
editor

In MPI Artifact View

sort by any column
(click on col. heading)
Navigate to source code
line by double-clicking
on the artifact

Run the analysis on
another file and its
markers will be added to
the view

Remove markers via | ) o

Module 3

’ Show MPI Artifacts
’ Show OpenMP Artifacts
/7 MPI Barrier Analysis

ef3a# Navigate Search Project Run Window Help

Qv B f}v OV q‘v ov

5 |ERIC/CH++
8% Outli 2
% RN e

= mpi.h

I stdio.h
= string.h

a0 | Efy Biv iy G = 45

Cle Gle ¥ e Do
{25 Project Explorer &3 = =0
source;

dest = 0;
tag = 0;
message[100];
status ;

int

int

char
MPI_Status

¥ 2 MyMPlproject
T sage
b 35 Binaries return status for receive

P wYIncludes

v (Bsrc start up MPI © calc_piint, int)

MPI_Init(&arge, &argv); @ main(int, char'[

find out process rank

MPI_Comm_size(MPI_COMM_WORLD, &num_procs);

[

ix‘:::;vmﬁ

I LineNo
22

37

57

I Filename | Construct

» MPI_Bcast

» MPI_Reduce
» MPI_Init

»

P MPI_Comm_size
» MPI_Send

» MPI_Recv

» MPI_Bcast

¥ MPI_Finalize

MyMPlproject.c Function Call

MyMPlproject.c Function Call
MyMPlproject.c Function Call
63
70
75
84

94

MyMPlproject.c Function Call

MyMPlproject.c Function Call
MyMPlproject.c Function Call
MyMPlproject.c Function Call

MyMPlproject.c Function Call

Wiritable Smart Insert | 60: 18

PTP Tutorial
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MPI Barrier Analysis

= C/C++ - MyBarrier/src/MyBarrier.c - Eclipse SDK - C:\ews\runtime-cdt40

File Edit Refactor Source Statistics Navigate Search Project Run Window Help

010
¥

2 :
y &
~ P

L Project Explorer &2

= g§ MyBarrier
#- )} Indudes
=3 src
+ g‘g’ MyBarrier.c
+- (= Debug
+ IDC‘ MyCproject
# x5 MySampleProject

G- aiv [ @

=0 |.€] matrixio.c

& | B c/c++ |
L Resource

$-0-Q-i® 5 O-

gé_;)MyBarrler.c pX{ = O |[ 5= outline 2 (@) Make Targets| = O

if (my rank !=0){ L

|.¢] zzzzTemplateTest.c

R o °

H stdio.h

™ string.h

™ mpi.h

@ Barrier() : void

@ main(int, char*[]) : int

sprintf (message, "Greetings from process %d! o
dest = 0;

MPI_Send (message, strlen(message)+1l, MPI_CHI
dest, tag, MPI_COMM WORLD):
MPI Barriexr (MPI_COMM WORLD) ;
}

else{

printf ("From process 0: Num processes: %d\n'

for (source = 1; source < p; source++) {
MPI_Recv(message, 100, MPI_CHAR, source,

MPI_COMM WORLD, &status):;

printf ("$s\n",message);

}

MPI Barrier (MPI COMM WORLD) ;

Ba::i;: (0 B B

/7, MPI Barriers ¢ o v

<] >
Function |2 Problems | | Tasks | E] Console | "% Barrier Matches 5% = O || ¥4 Barrier Errors 2 i ¥ =08

i ¥ Barrier Matching Set Function

Barrier Matching Set Function Filename LineNo | =) W4 Error L
=W Barrier 1 (2) Barrier & W Path 1 (1 barrier(s)
i Barrier 1 Barrier Yl Path 2 (0 barrer(s))
/7, Barrier 3 =R
Barrier : 44 Loop (dynamic number of barriers)
=W Barrier 2 (1) main = 0y
i Barrier 2 main
=W Barrier 3 (2) main
/i Barrier 1 Barrier
i Barrier 3 main
/4 Barrier 4 (0) main
+- W Barrier 5 (1) main

MyBarrier.c 8

MyBarrier.c 8

MyBarrier.c 41
MyBarrier.c 31
MyBarrier.c 31
MyBarrier.c 41
MyBarrier.c 8

MyBarrier.c 41
MyBarrier.c 57
MyBarrier.c 62

PTP Tutorial

Verify barrier
synchronization in C/
MPI programs
Interprocedural static
analysis outputs:

+For verified programs,
lists barrier statements
that synchronize
together (match)

+ For synchronization
errors, reports counter
example that illustrates
and explains the error.
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MPI Barrier Analysis - V|ews

/7 MP1 Barriers 23 = B |/[2. Problems | | Tasks | &l Console | % Barrier Matches &2 = O || Barrier Errors &2 i =0

i v Barrier Matching Set Function
=" Error main
+-W Path 1 (1 barrier(s))
i Path 2 (0 barrier(s))
=W Error main
+-" Loop (dynamic number of barriers)

Barrier Matching Set Function Filename LineNo [
=W Barrier 1 (2) Barrier MyBarrier.c 8
main i Barrier 1 Barrier MyBarrier.c 8
main /i Barrier 3 main MyBarrier.c 41
main =" Barrier 2 (1) main MyBarrier.c 31
main /i Barrier 2 main MyBarrier.c 31
Barrier =W Barrier 3 (2) main MyBarrier.c 41
/i Barrier 1 Barrier MyBarrier.c 8
/i Barrier 3 main MyBarrier.c 41
i Barrier 4 (0) main MyBarrier.c 57
+- W Barrier 5 (1) main MyBarrier.c 62

>l

MPI Barriers view Barrier Matches view Barrier Errors view

Groups barriers that

match together in a If there are errors, a

double-click to processes must go shows paths with
navigate to source through a barrier in mismatched number
code line (all 3 views)  the set to prevent a of barriers

deadlock

Simply lists the barriers

PTP Tutorial
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-u '.?3

OpenMP Managed Build Project

+ If you haven't set up - -]

C Project

O p e n M P p refe re n Ces e . g . Create C project of selected type
include file location, do it projct name: | MyOpenMPproject
n O W Use default location

+ Create a new OpenMP T
project

® Hello World C++ Project

File» New »C Project ® Hello World ANSI C Project

@ Empty Project

Name the project e.g. ® MPI Hello World C Project

@ MPI Empty C Project

‘MYOpenMPprOJeCt, ® OpenMP Hello World C Proj
Select openMP Hello World C ® OpenMP Empty C Project

(=>Shared Library

Project , & Static Library E]E]
-
Se I eCt N eXt, th e n fl I I | n Oth e r Show project types and toolchains only if they are supported on the platform

info like MPI project

|

PTP Tutorial
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Setting OpenMP Special |
Build Options

= Properties for MyOpenMPproject

+ OpenMP typically requires |[FEE= Settings

Resource

special compiler options.

=) CjC++Build Configuration: |Debug ¥ | | Manage

+ Open the project s b

Zeiii & Tool settings | # puild steps Build artifact | |a19 Binary parsers | @

rO p e rt I e S Tool chain editor
p Variables = Other flags | -c -fmessage-length=

+- C/C++ General

+ S e | eCt C / C + + B u i I d Project References ) [Jverbose (-v)

Refactoring History [Jsupport ANSI programs (-ansi)
Run/Debug Settings

+ Select Settings
+ Select C Compiler

+In Miscellaneous,
add option(s). (B riclaneons

& Shared Library Se =

>

PTP Tutorial




¥ Show MPI Artifacts

¥ Show OpenMP Artifacts <
#7i MPI Barrier Analysis

)DEe oA >

= C/C++ - MyOpenMPproject/src/MyOpenMPproject.c - Eclipse SDK - C:\ews\runtime-temp

l=Jojes

File Edit Refactor Navigate Search Project Run Window Help

G~ ei- 6@~
77/ ¥o oo

Ci~ gl 010 B0~ G- O-
> ® s

L5 Project Explorer &3 = O || [g) *mMyopenMPproject.c &2

F %5 Debug |G cjc++ |8 Java

= E Ou o ))1 (=} E

5 v double *x, *y; v ¥ 2 W e
S p:int:("ié"; OpenMP World » lz \ x 9
=125 MyMPIproject e - R 2 stdio.h
#-[a) Indudes ™ string.h
(B src U stdib.h
+-(= Debug ’ ™ math.h
c - printf ("true”); a
=tz MyOpenMPproject ' = openmp.h
#[m)} Indudes T, . @ main(int, char
- Allocate memory for the arrays
L+ EM OpenMPoroject X = (double *) malloc( (size t) ( arraySize * sizeof (do
" y ni I . -
yope project.c Yy = (double *) malloc( (size t) ( arraySize * sizeof (do
+-(= Debug -
* Here's he for-1lo (=]
’ #pragma omp p
for (1 = 0; i < arraySize; i++ )
{ o
v[i] = sin( exp( cos( - exp( sin(x[i]) ) ) ) ):
}
return 0;
}
v
< > < >
2 Problems | 77| Tasks =] Consoladtnshugsudpumiinprobien)P 9 OpenP Artifact View 53 = 0O
T
OpenMP Artifact Filename LineNo Co
# omp_in_parallel MyOpenMPproject.c 26 Fur
#pragma omp parallel for MyOpenMPproject.c 34 Opt
< >
Q
P P O Cl O
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- ‘.:‘\\

Show Pragma Region

Run OpenMP

analysis B toragua omp paraiict for I
R|ght CIle On fo:‘ (i=0; i < arraySize; i++ )
pragma in ,
artifact view e

<

v[i] = sin( exp( cos( - exp( sin(x[1]) ) ) ) )’

|2 Problems | | Tasks | E] Console | %f Debug | ‘@ OpenMP Problems | #9» OpenMP Artifact View £33

Se l ect S h ow OpenMP Artifact Filename LineNo
p ra g m a reg I o N omp_in_parallel MyOpenMPproject.c 26

T T pject.c 34
Show pragma region

See highlighted region in C editor

PTP Tutorial
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Show OpenMP Problems

< C/C++ - MyOpenMPproject/src/openMPproblems.c - Eclipse SDK - C:\ews\runtime-temp Q@
File Edit Refactor Navigate Search Project Run Window Help

O RN C I N 2~ Q Y %5 Debug
S R @

+ SeleCt OpenMP = e s ARSI Bg c/c++ |8} Java

L Project Explorer &2 =08 |.c| *MyOpenMPproject.c .| openMPproblems.c &3

prObIemS View 2~ » f#pragma omp paralﬁ:t)al:for

+ Will identify standard v
OpenMP restrictions e }

=125 MyMPIproject for(3=1; 3j<10; j+

void barriercheck4 ()

4 .| MyOpenMPprofagt.c int i, 3j;
+|.c| openMPproblems.c I
+-(Z= Debug fpragma omp parallel

i=0-+

i=0; i<3; i++)

{2 Problems | | Tasks | E] Console | @ OpenMP Problems 52 . §P» OpenMP Artifact View

Description
& For directive embedded within another parallel for or parallel sections
& Barrier directive not permitted in region extent of for, ordered, sections, single, master, and critical

Writable Smart Insert 26:5

PTP Tutorial
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Show Concurrency

Highlight a statement int simple(3{

Select the context menu
on the highlighted
statement, and click
Show concurrency

Other statements will be
highlighted in yellow

The yellow highlighted
statements might execute
concurrently to the
selected statement

PTP Tutorial
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Module 4: Parallel Debugging

+ Objective

+ Learn the basics of debugging parallel programs with
PTP

+ Contents
+ Launching a parallel debug session
+ The PTP Debug Perspective
+ Controlling sets of processes
+ Controlling individual processes
+ Parallel Breakpoints
+ Terminating processes

Module 4 PTP Tutorial
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Launching A Debug Session

Use the drop-down next to

the debug button (bug
icon) instead of run button

Select the project to launch

The debug launch will use
the same number of
processes that the normal
launch used (edit the
Debug Launch
Configuration to change)

:;}v uv Q/“v Ov

= 1 MyMPIProject

i  Debug As
% Open Debug Dialog..”
Organize Fayorites...

Module 4

& PTP Runtime - job05:0 - Eclipse SDK

File Edit Refactor Navigate Search Run Project Window Help
P —

o Y Ov Qv | O | =

010

(3 Resource Managelg - 1 MyMPIProject

|‘[> & ORTE @scO7tut Debug As 4
%5 Open Debug Dialog...
Organize Favorites...

882 Machines 52 & (v

ORTE@scO7tutorial: localhost.localdomain - Root [64]

= | REEEENTTT T
10 [ i I e ) I )
20 [ () I ) ) I O B B
30 [ e ) I I S
40 [ [ I ) ) I O B
SO [ I ) I I ) O I )
60 Bl i B B

Node Attributes Process Info

Attribute Value
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The PTP Debug Perspective (1)

& PTP Debug - MyMPIProject/testMPI.c - Eclipse SDK
File Edit Refactor Navigate Search Run Project Window Help

+ P_a ra I IEI De b_u g g = | Oy Qv |[Ov | 3= | 4 =5 [£5PTP Debug| % PTP Runti... FEC/C++
VI ew S h OWS JO b ¥ Parallel Debug &2 = B 9 Breakpoints = Variables $2 & Expressions
and processes ORTE@scOTtutoal d gy n o g 0 & =
being debugged £ jobo2 o Name Value

> job06 { [ % my_rank 4545765
% num_procs 134515657
% Debug 2 B 3 , =g

Debug view shows ke

¥ &3 MyMPIProject [Parallel Application] ® des )
threads and call © 8@ process 0 :
stack for individual e
Processes

[¢ testMPl.c 82 888 job05:0 = 0 5= outline
{ [~ 4 W W
. int my_rank; * rank of pro vz
Sou rce VIeW int num_procs; r'n?nldi%r' of p es & mpih

int source; /* rank of sender #

ShOWS a Cu rrent int dest = ©; rank of l‘ece%“ r ¥/ .

int tag = 0; /* tag for mess S string.h

I | ne ma rke r fO r a I I char message[160]; storage for N - - calc_pi(int, int) : void

MPI_Status status ; /* return status fo
p ro Cesses main(int, char#[]) : int
¥ start up MPI #
MPI_Init(&argc, &argv);
* find out process rank #

MPI_Comm_rank(MPI_COMM_WORLD, &my_rank);

[l Console 2 [ Memory €] Error Log [Z. Problems
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The PTP Debug Perspective (2)

File Edit Refactor Navigate Search Run Project Window Help
By Oy Qv | O | s £ |#2PTP Debug| &8 PTP Runti... [@C/C++

¥ Parallel Debug &2 sl ©o Breakpoints (9= Variables 82 &7 Expressions

+ Breakpoints view : : EEIrTIe - % E
shows breakpoints |Gz Name Value

that have been set |e=== — e

” =g
% Debug 2 1 % source -1076822980

(mOre On th'S |ate|’) - 8= MyMPIProject [ParallslApphesd % dest -1076823128

Va riables VIEW /® Thread [1] (Suspended)
shows the current Sl
values of variables /[T TEs = 0|2 outine

{ ) LA +az \ \E'

for the CU rrently int my_rank; /* rank of pro

int num_procs; number of p sses & mpi.h

int source; /* rank of sender # stdio.h

Selected process in @nt dest = 0; rank}‘)f receiver */ ‘
int tag = 0; /* tag for messages *, string.h
1 h 0] ; storage fo ge e -
the Debug VIeW F’IP?ﬁStatus I:iZ;ane;[mO] r':twllrﬂ] SLLH‘; or receiv Ca[c_(m(mt,;nt)[.])vmd
main(int, char¥[]) : int
Outline view (from e e
MPI_Init(&argc, &argv);
CDT) of source

code

\74\\,4,|,},v,,,,, i
MPI_Comm_rank(MPI_COMM_WORLD, &my_rank);

[l Console 2 [ Memory €] Error Log [Z. Problems
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The buttons in the
Parallel Debug View
control groups of
processes

Click on the Step Over
button

Observe that all process

icons change to green,
then back to yellow

Notice that the current

line marker has moved to
the next source line

Module 4

7% Parallel Debug 53 13
ORTE@sc07tutorial: default:job06 - Be®

%5 Debug 52

— &2 MyMPIProject [Parallel Application]
< &2 Process 0
< o Thread [1] (Suspended)

[¢) testMPl.c &8 &5 job05:0

/* start up MPI */
MPI_Init(&argc, &argv);

/* find out process rank *#
MPI_Comm_rank(MPI_COMM WORLD, &my_rank);

/¥ find out number of processes #
MPI_Comm_size(MPI_COMM_WORLD, &nhum_procs);

PTP Tutorial




+

+

e

The buttons in the
Debug view are used
to control an
individual process, in
this case process 0

Click the Step Over
button

You will now see two
current line markers,
the first shows the
position of process 0,
the second shows the
positions of processes
1-3

Module 4

File Edit Refactor Navigate Search Project Run
ips S W | % Oy @ Qv |0 | =

7% Parallel Debug 2
ORTE@Local: default:job02 - Root [4]
# 0 =% v

Orrr

-] m 2 G
£ job02

%> Debug 2

23 _H =

¥ 2=t MyMPIProject [Parallel Application]
<~ &2 Process 0 (Suspended)
~ 4 Thread [1] (Suspended)

lc, MyMPIProject.c &3
MPI_Init(&argc, &argv);

/¥ find out process rank *
» MPI_Comm_rank (MPI_COMM_WORLD, &my_rank);

/* find out number of processes #
> | MPI_Comm_size(MPI_COMM_WORLD, &nhum_procs);

if (my_rank != @) {

Window Help

LYilv Siwv v
U =

= 8 ||%Br|6fE 0=V R - EESi|ERArEP

Name Value

@ my_rank 0
134515657
-1081228708 |

n

% num_procs
% source

o= Outline 82
B R e Y

= mpi.h

= stdio.h

= string.h
calc_pi(int, int) : void

main(int, char#[]) : int

El Console 52
0

0 Memory [Z. Problems

Writable Smar...sert
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Process Sets (1)

+ Traditional debuggers apply operations to a single
process

+ Parallel debugging operations apply to a single process
or to arbitrary collections of processes

+ A process set is a means of simultaneously referring to
one or more processes

Module 4 PTP Tutorial
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Process Sets (2)

+ When a parallel debug session is first started, all
processes are placed in a set, called the Root set

+ Sets are always associated with a single job
+ A job can have any number of process sets
+ A set can contain from 1 to the number of processes in

Module 4 PTP Tutorial
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Operations On Process Sets

+ Debug operations on the
Parallel Debug view
toolbar always apply to the
current set:

+ Resume, suspend, stop,
step into, step OVEer, step
return

+ The current process set is
listed next to job name
along with number of
processes in the set

The processes in process
set are visible in right hand
part of the view

Module 4

7% Parallel Debug 2 13 @ |
ORTE@sc07tutorial: default:job06g,Root [4]

£) job02 o#]+ + +
> job06

%> Datflig 2
~ &= MyMPIProject [Pargifel Application]
v &2 Process 0
< o Threp@[1] (Suspended)

1 main() testMPl.c:50 80489b0

Root set = all
processes

PTP Tutorial
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Managing Process Sets

+ The remaining icons in the toolbar of the Parallel
Debug view allow you to create, modify, and delete
process sets, and to change the current process set

Create set Remove
from set

7% Parallel Debug 52 g @ 2 C
ORTE@scO07tutorial: default:job06 - Root [4] 7 Cha ng e
Qjob?? 0>+ current set

" 1ob06

%> Debug 22 13 D Delete

< &3 MyMPIProject [Parallel Application] set
< &2 Process 0
< o Thread [1] (Suspended)

= 1 main() testMP:
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Creating A New Process Set

Select the processes
you want in the set by
clicking and dragging,
in this case, the last
three

Click on the Create
Set button

Enter a name for the
set, in this case
workers, and click OK

You will see the view
change to display only
the selected processes

Module 4

e X b @
ORTE@sc07tutorial: default:job06 - Root [4]
-jobe o[z]¢ ¢ ¢
¥ job06

-

~— Create a new set name

is ey 2 Please enter the new set name.

v E 3 MyMPIPrO]eCt ' ’.Workers
< & Process 0 (Sul
v 4@ Thread [1]

w=Rarallel Debug &3 I3 W -
ORTE@sc07tutOrtek=default:job06 - workers [3]

PTP Tutorial
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File Edit Refactor Navigate Search Project Run Window Help

+ With the workers set Fov = |3y O Qv Qv | O~ | 3= | 4 S g »
aCtIVG, C“Ck the Step 7 Parallel Debug 2 = 0| %BrdfE ®-V 2 FESi ZFLArpp =0
Over button RTE@bacal: default:job04 - workers [3] & B <

3 =] v F 1 &>
e b U U Name Value

+ You will see only the 2 jobo2 1e s

first current line A =
marker move

If a I I p rocesses are now 8= MyMPIProject [Parallel Application]

&= MyMPIProject [Parallel Application]

%5 Debug £

at the same line, you

will only see one line -
marker agaln MPI_Init(&argc, &argv); [~ B R e T

/* find out process rank */ = mpi.h

[ MyMPIProject.c £ = 8 | gz outline &

MPI_Comm_rank (MPI_COMM WORLD, &my_rank); = stdioh

/¥ find out number of processes */ =1 string.h
3 MPI_Comm_size(MPI_COMM_WORLD, &nhum_procs); calc_pi(int, int) : void

main(int, char*(]) : int
El Console 2 [ Memory [Z. Problems

C-Build [MyMPIProject]
make: Nothing to be done for “all'.

Module 4 PTP Tutorial




paratel—toois—platiform

Process Registration

+ Process set commands apply to groups of
processes

+ For finer control and more detailed
information, a process can be registered and
isolated in the Debug view

+ Registered processes, including their stack
traces and threads, appear in the Debug view

+ Any number of processes can be registered,
and processes can be registered or
un-registered at any time

Module 4 PTP Tutorial




+ To register a process,

double-click its process
icon in the Parallel
Debug view or select a
number of processes and
click on the register
button

The process icon will be
surrounded by a box and
the process appears in
the Debug view

+ To un-register a process,

double-click on the
process icon or select a
number of processes and
click on the unregister
button

Module 4

oy

7% parallel Debee

ORTE@scO07tutorial: default:jolUo==.
£) job02

¥ job06

%> Debug 2
~ 52 MyMPIProject [Parallel Application]
~ &2 Process 0 (Suspended)
v o Thread [1] (Suspended)
= 1 main() testMPIl.c:63 804890
~ &2 Process 3 (Suspended)
< ® Thread [1] (Suspended)

[¢ testMPl.c £ 888 job05:0

PTP Tutorial

Groups (sets)
of processes

Individual
(registered)
processes
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Current Line Marker

+ The current line marker is used to show the
current location of suspended processes

+ In traditional programs, there is a single
current line marker (the exception to this is
multi-threaded programs)

+ In parallel programs, there is a current line
marker for every process

+ The PTP debugger shows one current line
marker for every group of processes at the
same location

Module 4 PTP Tutorial
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Colors And Markers

[d testMPl.c 82 - g8 job05:0
+ The highlight color depends on /+ start up W1 *
the processes suspended at WPI_Init(sarge, Sargv);
that line: R T A—

* Blue: A” regIStered prOCGSS(eS) * find out number of processes */
. = MPI_Comm_size(MPI_COMM_WORLD, &num_procs);
+ Orange: All unregistered
process(es)

4+ Green: Registered or unregistered eI RNR KT HREET0E

process with no source line (e.g.
suspended in a library routine)

Multiple processes marker

+ The marker depends on the

type of process stopped at that Registered process marker
location

Ed Un-registered process marker

Hover over marker for more

details about the processes Multiple markers at this line

Suspend at that location -Suspended on unregistered process: 2
-Suspended on registered process: 1

Module 4 PTP Tutorial
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Breakpoints

+ Apply only to processes in the particular set that is

active in the Parallel Debug view when the breakpoint
is created

+ Breakpoints are colored depending on the active
process set and the set the breakpoint applies to:

+ Green indicates the breakpoint set is the same
as the active set.

+ indicates some processes in the breakpoint set are
also in the active set (i.e. the process sets overlap)
+ Yellow indicates the breakpoint set is different from the
active set (i.e. the process sets are disjoint)
+ When the job completes, the breakpoints are
automatically removed
else{
| print
MPI_Final
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+ Select the process set that

the breakpoint should apply
to, in this case, the workers
set

Double-click on the left edge
of an editor window, at the
line on which you want to set
the breakpoint, or right click
and use the Parallel
Breakpoint» Toggle
Breakpoint context menu

The breakpoint on the call to
MPI Send()

Module 4
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¥ Parallel Debug 2 0B = i
ORTE@scO07tutorial: default:job06 - workers [3]
£) job02 1% [+
»: job06

& 0 8

%5 Debug &
~ 53 MyMPIProject [Parallel Application]
~ &2 Process 3 (Suspended)
v o Thread [1] (Suspended)

| testMPIl.c:63 80489e0

lc) testMPl.c 83 £ job05:0
1T (my_rank '=Uu) {
¥ create message *,
sprintf(message, "Greetings from process %d!",
/¥ use strlen+l so that '\@' get transmitted */
MPI_Send(message, strlen(message)+l, MPI_CHAR,
dest, tag, MPI_COMM WORLD);

my_rank) ;

} else {
printf("Num processes: %d\n",num_procs)
for (source = 1; source < num_procs; source++) {
MPI_Recv(message, 100, MPI_CHAR, source, tag,

PTP Tutorial
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& PTP Debug - MyMPIProject/testMPI.c - Eclipse SDK

* CIICk On the Resume bUttOﬂ File Edit Refactor Navigate Search Run Project Window Help
o - v aw | Y Qv @y | O | = »
in the Parallel Debug view ’

% Parallel Debug o% = (> ) & 0 8

4., In thls example, the th ree ORTE@scO07tutorial: default:job06 - Root [4]
worker processes have hit the |2 -
breakpoint, as indicated by
the yellow process icons and :
the current line marker o MyMPIProject [Parallel Application)

OE‘r r

- &2 Process 3 (Suspended)

Process 0 is still running as its ¥ Thread (1] (Suspended: Breakpoint hit)

\ =

|C0n |S green - &2 Process 0

@ Thread [1] (Running)

[¢ testMPl.c 82 - E& job05:0

if (my_rank != @) {
/* create message */
sprintf(message, "Greetings from process %d!", my_rank);
/¥ use strlen+l so that '\0' get transmitted #
MPI_Send(message, strlen(message)+l, MPI_CHAR,
dest, tag, MPI_COMM_WORLD);
} else {
printf("Num processes: %d\n",num_procs);
Emww [ mmtsmmn L e e s A, - .

-1 -~ At
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More On Stepping

The Step buttons are only

enabled When a” processes ' FrPDob.u- - MyMPIProject/testMPI.c - Eclipse SDK
in the active set are N

suspended (yellow icon) e R

In thls Case, process O |S Stl” SREE@scO7tutorial: default:job06 - Root [4]
running —o @

Switch to the set of
suspended processes (the & | % 0 v O |z | 4 _
workers set) & parallel Debug 7 ——a s o om0l &g & ole o

ORTE@scO07tutorial: default:job06 - workers [3]

You will now see the Step Qoz v
buttons become enabled ¥ jobos
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Breakpoint Information

+ Hover over breakpoint icon
+ Will show the sets this breakpoint applies to

+ Select Breakpoints view
+ Will show all breakpoints in all projects

9 Breakpoints £  ®)=Variables &< Expressions

~"

% @)- \ + - ) 2

Module 4 PTP Tutorial
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- ‘—:‘\\

Breakpoints View

+ Use the menu in the breakpoints view to group
breakpoints by type

+ Breakpoints sorted by breakpoint set (process
set)

9 Breakpoints £2 = Variables & Expressions

® & % BB g
Show Full Paths

& testMPl.c [line: 70] {job03:workers} m— N 01 Breakpoints

oo Select Default Working Set... = ()2 Breakpoint Types
(3 Breakpoint Working Sets
Working Sets... (4 Files
[ ] Show Qualified Names . .
= ()6 Projects
(7 Resource Working Sets
()8 Advanced...

Module 4 PTP Tutorial
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Global Breakpoints

+ Apply to all processes and all jobs
+ Used for gaining control at debugger startup

+ To create a global breakpoint

+ First make sure that no jobs are selected (click in white
part of jobs view if necessary)
+ Double-click on the left edge of an editor window

+ Note that if a job is selected, the breakpoint will apply to
the current set

if (my _rank '=0) {
/* create message */

Sprintf(message, "Greetin

Module 4 PTP Tutorial
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File Edit Refactor Navigate Search Run Project Window Help

F9v = ;;;V Qv |;«.~.v O~ = =17 By |@
i3 Parallel Debug &8 m— - o & = B|eg
ORTE@scO07tutorial: default:job06 - Root [4]
£ job02 CEF¥¥¥
\9 _};.;‘;l_ i
%> Debug £ v =a

&= MyMPIProject [Parallel Application]
@ Para"el Debug =3 13 L!l 2 2 (‘3) {} =, {) & = = H OO B
ORTE@scO07tutorial: default:job06 - Root [4]
£) job02 0 > P 9P "
Q job06
%> Debug &2 il & .G v =8
— 82 MyMPIProject [Parallel Application]

< &2 Process 0 (Suspended)
v 4 Thread [1] (Suspended)
= 1 main() testMPI.c:63 80489e0
» D O A
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Module 5: Advanced Development

+ Objective
+ Explore advanced features of Eclipse and PTP

+ Contents
+ Advanced Eclipse Features

+ Advanced PTP Features

PTP Tutorial
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Advanced Eclipse Concepts

+ Perspectives, views and preferences
+ Version control

+ Makefiles and autoconf

+ Task Tags

+ Searching

+ Refactoring

PTP Tutorial
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Customizing Perspectives

+ Items such as shortcuts, menu items and views may be
customized

+ Window» Customize Perspective...
+ Save changes

+ Window» Save Perspective As...
+ Close Perspective

+ Right-click on perspective title and select Close
+ Reset Perspective

+ Window» Reset Perspective resets the current
perspective to its default layout

PTP Tutorial
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Opening New Views

+ To open a view: Show View
+ Choose Window» Show View » Other...
¥ = General
+ The Show View dialog comes up WBookmarks

» Classic Search

+ Select the view to be shown B Coneole
+ Select OK ¥ Internal Web Browser

©-Navigator
o= Outline
(2. Problems
€ Progress
{3Project Explorer
! Properties
v Search
¢ Tasks
P (= Ant
P =C/CH+ o

o [ coma |

PTP Tutorial
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Workbench Preferences

+ Preferences provide a way for you to
customize your Workbench

+ By selecting Window » Preferences... or
Eclipse» Preferences... (Mac)

+ Examples of preference settings

+ Use Emacs bindings for editor keys
+ Modify editor folding defaults

+E.g., fold all macro definitions
+ Associate file types with file extensions
+E.g., *.f03 with the Fortran editor
+ Toggle automatic builds
+ Change key sequence shortcuts

+E.qg., Ctrl+/ for Comment

Module 5 PTP Tutorial
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Version Control (CVS)

+ Version control provided through the Project
Explorer View, in the Team context menu

4+ Provides familiar actions:

Open
Open With

+ Commit... ShowlIn %W
+ Update . = Copy
Synchronize with Repository

12 Paste Commit,,, <

+ Also less used tasks: X Delet o | Gotete e

Build Path Create Patch...

+ Create/Apply Patch... RafactorCHT i

[— Tz Tag as Version...

+ Tag as Version b7 Export.. + Branch...

1k Merge...

« Refresh F5 Switch to Another Branch or Version...
+ B ra n C h san Assign Working Sets... fi) Show Annotation

.| Show History
Validate

+ Merge... Run As

Debug As

+ Ad d to . CVS | g n O re Lo Profile As Change ASCII/Binary Property...

Compare With
Replace With
Source

Revert to Base
Show Editors

Properties

PTP Tutorial
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Specify Repository Locations

Select Window }Open Add a new CVS Repository

- Add a new CVS Repository to the CVS Repositories view
Perspective » Other... y i

Select CVS Repository EXploring Je—
then OK Host: dev.eclipse.org

Repository path: | /cvsroot/tools

Right-click in CVS Repositories
View, then select
New » Repository Location... Password:

Set Host to the hostname of —

remote machine @ Use defaul port

Set Repository path O use port

Fill in Username and Password T:ij‘;‘;:';:“‘°"°"f""‘sh

Set Connection type b impostile, or an ncrudertoread. e et but e
Check Save password Confiaure connection preferences...

Select Finish

PTP Tutorial
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Checkout a non-Eclipse project as an
Eclipse C Project

+ Open Repository, open HEAD New

- i ; Check Ou
+ Loca_te project, right-click on TG As.
Project»Check out As...

. i@ Tag as Version...
+ Make sure Check out as a project Tag with Existing...
configured using the New Project 000

Wizard iS selected CS:::cc':::!n:(shodofche(kou!
+ Select Finish

Check Out As

Choose how to check out folder 'old"

- @ Check out as a project configured using the New Project Wizard
+ Select C»C project

’:" Check out as a project in the workspace

+ SeIeCt NeXt> O P:wName: : New Project
+ Enter Project name

+ Under Project Types, select Makefile
project

i type filter text
+ Ensures that CDT will use existing Baroie s
NELGEIIES

“ Plug-in Project [~ Shared Library

o) n h Vi (= Static Library
+ Select Finish

5 C Project <> Executable (XL C/C++)
> B Ctt < Static Library(XL C/C++)
+ Switch to the C/C++ Perspective O shared Lbrary (XL €/C:++)
.~ Makefile project

Create a new C project

Project types:

PTP Tutorial
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About Makefiles and autoconf

+ Can create project Makefiles with the Makefile
Editor

+ Syntax highlighting and Outline view
+ autoconf often used to create Makefiles for
open source projects

+ Run configure manually, or from External
Tools Launch Configuration
+ Must refresh after running configure script

+ Refresh whenever file system is modified
outside of Eclipse

PTP Tutorial
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Building with Makefiles

£ |FEIC/C++| BaCVS Repo...

+ Create a Make Target
named ‘all’
+ Right-click on the

project in Make
Targets View

4+ Select Add Make
Target
+ Select Create

+ Double click on new
make target to initiate
the build

Target Name: ‘i-\l‘_

Make Target

Make Target: |all

Build command
v! Use default

Build command:

Build Setting

Stop on first build error.

v| Run all project builders.

Create

PTP Tutorial

= B 5= Outline (@) Make Targets &3 = B8

a4

» £ MyCVSProjec

b & MyMPIProjec I Sagg Makearget

E Ereafe a new ﬁake Eargef S

b’

Cancel
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Task Tags

l.c| MySampleProject.c &3

+ Task tags are identifiers in C/
C++ comments

+ TODO is a built-in task tag

+ The build locates task tags :
during compilation #inolade <stdio.n>
+ View task tags in Tasks View § 6
+ If it's not shown, Window
» Show View » Other...
Open General and select [Er=sEp 5 s )

Filter matched 3 of 8 items

Ta S ks v ! Description Resource Path

MyTag a sample task tag MySamplePr... MySampleProject/src
MyTag like this MySamplePr... MySampleProject/src

+ CO n fi g u re yo u r O W n ta S k ta g TODO this is a built-in task tag MySamplePr... MySampleProject/src
in Window » Preferences

+ Under C/C++, select Task
Tags
Module 5 PTP Tutorial
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Searching

[0 Project Run Window

Language_based g R Ctrl+H
searching J
Search for Language
Elements —
+ e.g., C++ Class, T

Search string (* = any string, ? = any character):

FLInCtIOn, MethOd, - e | Case sensitive
Va rla ble, Fleld, Search For Limit To

| Class /Struct [] Function | Variable Declarations Definitions

N a m eS pa Ce ] Union ] Method [] Field References @ All Occurrences
Ca n Li m it Sea rC h to j\ Enumeration j]Enume[ator [] Namespace
0 o onc [ Typedef [J‘Any Element,
Declarations, Definitions, |
References o workspace
. . ) Working set: Choose...
Type navigation

(?) |Customize... Cancel

PTP Tutorial
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UPC Support

Select the features to install:

¥ 9| TutorialCD/updatesite

¥ UUU CDT 4.0.3.200802251018
<)== Eclipse C/C++ Development Tools SDK 4.0.3.200802251
«J= Eclipse C/C++ GDB Hardware Debugging 4.0.3.2008022!
= CO0-Re "=3=200802251018
«J== Unified Parallel C Support4.).3.200802251018
== - pport 4.0.3.200802251018
<) Eclipse CDT Testing Feature 4.0.3.200802251018

» LUU Parallel Tools Platform 2.0

+ Filetypes of “upc” will . —

get UPC syntax high- '/ private variables

i : i / [ eremeng the matrix a[][]

lighting, content assist, LoB: iz Laet SaFLIED

etc. 7705 j<P; j+4)
a[1][J]=1*P+]+1;

+ To see UPC support in C
editor, install the optional
feature from CDT

| |
| ]
| |
| ]
| ]
| |
| ]
| |

// intialize the matrix b[][]
upc_forall(j=0; j<M; j++; &b[0]1[3])
for (1=0; 1<P; 144)
b[1][3]=3%2;
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Refactoring

+ Source-to-source transformation that
preserves behavior
< C/C++ - MyCproject/src/MyCproject

* Rena me File Edit Refactor\Navigate Search Proje
i Bt Rename... Alt+Shift+R c";
+ Select C/C++ Perspective |
+ Open a source file
+ Click in editor view on declaration of a variable

+ Select menu item Refactor» Rename
4+ Or use context menu

+ Change variable name
+ Notice that change is semantic not textual
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CDT 5.0 Refactoring: Extract Constant

int main(void) {
®No Refactoring double intvalue-0.0}

The following changes are necessary to perform the refactoring. Source H
Rename...

Changes to be performed Declarations Extract Constant...
M v @3 Changes ) -

o I + CDT 5.0 will be available
in the Eclipse "Ganymede”

Original Source Refactored Source release’ June 2008

#include <stdio.h> #include <stdlib.h>

#include <stdlib.h> | + Other refactorings that

__—{static const float MYZERO = 9.9;

int main(void) { [int main(void) { are planned:
double intvalu double intvalue=MYZERO; )
puts("111Hello NOPEEI11"); /* prints | puts("111Hello World!!1"y; /% prin Extract Function
t EXIT_SUCCESS; t EXIT_SUCCESS; . .
y oo y o Hide Member Function
int foo(){ int foo(){ 3 A
e myin GoubTe oy inEHIZERD: Move Field or Member Function
Extract Subclass
Extract Baseclass
Separate Class
Implement Function
Declare Function
Move Function Definition
Generate Getters and Setters

PTP Tutorial 5-14
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O Finish )
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Advanced PTP Concepts

+ Remote resource managers
+ Debugging remotely
+ MPICHZ2, IBM PE and LoadLeveler

PTP Tutorial
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Remote Resource Manager

(S NONG)
ORTE Proxy Configuration

Select Remote Tools as the
Remote service provider

Click New... to create a new
location

Enter a Target Name, IP :
addreSS or hOSt name Of the Path to proxy executable: x.x86/bin/ptp_orte_proxy [ Browse/ / Options... )

Enter information to connect to an ORTE proxy server

Remote service provider: | Remote Tools T]

Ve

Proxy server location: Remote Host Al

remote maChine, and Multiplexing Options /
Credentials @ None ® N0 Target Environment Configuration

Remote Host /

Properties for connecting to a remote host

Select Finish

Select the Target Name you
just created for Proxy e —

server location if it is not "Launch serve s 932457 port: (22|
visible in the dropdown

Local addre

- Target name: VeryBigCluster
"
() Use port fi

Host Information

(@) Password based authentication

Password:

() Public key based authentication

File with private key:
Cancel ) Finish )

Passphrase:

ST
(" Advanced )

(" Cancel ) ( Finish )
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Select Proxy Agent

ORTE Proxy Configuration

Click Browse to select
the proxy server
executable

Open Root twisty

Now navigate to and
select the proxy

EXGCUta b I e Multiplexing Options /
. @ None .0 Browse File
CIICk OK { Select file: /

’/Users/greg/Documents/workspaces/ptp_i-

information to connect to an ORTE proxy server

Remote service provider: | 5 |

Proxy server location: ' VeryBigCluster ‘v 1 [ New..

Path to proxy executable: Ax.x86/bin/ptp_orte_proxy. ( Browse | [ Options... )

Local address

() Use port forw:

» (= org.eclipse.ptp.macosx.pp
v (= org.eclipse.ptp.macosx.x8
|=] .project
¥ about.html
v (= bin O
.cvsignore
» (= CVS
“2 ptp_mpich2_proxy
ptp_orte_proxy N\ (
“2 ptplib.py
README

srim

"1 Launch server m

Finish )

CETTTES

.
( Cancel )




paratel—toois—piat

Using Port Forwarding

S ONe)

ORTE Proxy Configuration

+ Port forwarding can be Enter information to connect to an ORTE proxy server
enabled to tunnel all
communication over a
single connection

If you don’t want to use | _ | |

port forwarding your Path to proxy executable: x.x86/bin/ptp_orte_proxy / Browse \ / Options... )
!

local machine must be Multiplexing Options

accessible from the ) None

remOte maChIne Local address for proxy connection: 9.67.154.242

+ Select your local machine’s
IP address from the
dropdown

+ Enter it manually if it's not
visible

4+ Click Finish

Remote service provider: | Remote Tools I3 |

Proxy server location: ‘» local |5 | '

(*) Use port forwarding

Cancel \ ( Finish \

PTP Tutorial
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Debugging Remotely

(&)

Debug

Choose remote resou rce Create, manage, and run configurations

Create a configuration to launch a parallel application in Parallel Debug Perspective

manager in Main tab

Click Browse and select
sdm executable on
remote machine (if path
is not correct)

Set Debugger session
address to the address
of the machine running
the proxy agent

+ The address must be
accessible from a cluster
node

Click Finish

filter text
37 Java Applicatiol
Ju JUnit
Ju JUnit Plug-in Test
4 OSGi Framework

&=} Parallel Application
5} debug fail

&= normal

5+ shallow

5+ shallow2

5=} shallow local

71 _Remote Java Apolic
4

Filter matched 19 of 19

Name: shallow2

kS

Main (£ Resources [%3% Debugger . ®)= Arguments | &/ Source| 2

4 Stop at main{) on s
Debugger Options
Path to debugger executable:

/home/greg/ptp/plugins/org.eclipse.ptp.linux.x86_2 / Browse )

Debugger session address:

cluster_head

) / Revert

@)

) ( Debug \

PTP Tutorial
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Alternate Resource Managers

+ An MPICH2 resource manager is provided

+ Use ptp mpich2 proxy when selecting proxy executable
+ PE and LoadLeveler

+ See help documentation that comes with PTP for
information on configuring and using

+ Debugging support for alternate resource managers will
be available in next version of PTP

PTP Tutorial
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Module 6: Where To Go Next

+ Objective
+ How to find more information on PTP
+ Learn about other tools related to PTP
+ See PTP upcoming features

+ Contents
+ Links to other tools, including performance tools
+ Planned features for new versions of PTP
+ Additional documentation
+ How to get involved

PTP Tutorial
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Information About PTP

+ Main web site for downloads, documentation, etc.
+ http://eclipse.org/ptp
+ Developers’ wiki for designs, planning, meetings, etc.
+ http://wiki.eclipse.org/PTP
+ Mailing lists
+ Major announcements (new releases, etc.) - low volume
+ http://dev.eclipse.org/mailman/listinfo/ptp-announce
+ User discussion and queries - medium volume
+ http://dev.eclipse.org/mailman/listinfo/ptp-user
+ Developer discussions - high volume
+ http://dev.eclipse.org/mailman/listinfo/ptp-dev

PTP Tutorial
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PTP-Related Tools

+ Performance Tools Framework

+ Tuning and Analysis Utilities (TAU)

+ TuningFork - Performance Visualization
+ Photran - Fortran Development Tools

PTP Tutorial
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PTP / Performance Tools
Framework

—<utility command="v. ="valgrind">
—<optionpane title= ratewith="">

</optionpane>

Goal:
</utility>

+ Reduce the “eclipse plumbing”
necessary to integrate tools

+ Provide integration for :
instrumentation, measurement, and |5

v Parallel Performar

analysis for a variety of performance [Ee=s
tools

= . ag =
+ Dynamic Tool Definitions: -
reate, manage, and run configurations Yz
WO r kfl O W S & U I uild C, C++ or Fortran applications with performance analysis tools. Launch parallel
rograms from within Eclipse via the PTP.

+ Tools and tool workflows are I8 %16 || wore: roursorirann

type filter text —
‘ e ‘ P§ Environment | 8 Parallel

specified in an XML file = e e | [T st v

Tools are selected and configured in
the launch configuration window

Output is generated, managed and — oy o ]
analyzed as specified in the
workflow

Module 6 PTP Tutorial
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PTP TAU plug-ins k.

www.cs.uoregon.edu/research/tau/home.php

TAU (Tuning and Analysis Utilities)
First implementation of Performance Tools Framework

Eclipse plug-ins wrap TAU functions, make them
available from Eclipse

Compatible with Photran and CDT projects and with
PTP parallel application launching

Other plug-ins launch Paraprof from E

PTP Tutorial




paratel—toois—platiform

TuningFork

+ http://www.alphaworks.ibm.com/tech/tuningfork

+ Performance visualization Eclipse plug-ins from
IBM Research

+ Rich Client Platform; IDE version in progress

+ Designed for real-time V|suaI|zat|on of Iarge
data sets =

+ Will be available open
source on Source Forge

+ Enhancements for parallel |
computing underway

PTP Tutorial
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Photran

Supports Fortran in
the Eclipse workbench

Supports Fortran 77, 90,

and 95
It includes:

Syntax-highlighting editor
CVS support
GUIl interface to gdb

Makefile-based
compilation

Compiler error extraction
Outline view
Open declaration

Rename and Introduce

Implicit None refactorings
Module 6

ff Fortran Projects &2 F 3

f
Il > =mmrp
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http://eclipse.org/photran

nruu&‘ k_:]@@

| File Edit Navigate Search Project Run Window Help

. o - . \
v o1 By Q- Q- | [F~ v B | > 5 |Eg Fortran

o= outline &2 =8

.az w” X © e

module Mdataset bl || —

] < -
implicit none 7 ) Mdataset

¥ i35 >org.eclipse.photran-samp v J Tdataset

! Declare Tdataset type to hold data point [
P < Binaries type :: Tdataset datapt
real 11 datapt(4,1000) npts
integer tionpts
src-fortran-and-c [ real ;i valsum(4)
src-gaussian-elimination | | © real Liuvalsum(4)
real tioXysum(3)
1 logical :: has_np(2)
end type Tdataset ® has_np

b src-fixed-form
valsum
valsum
src-includes Xysum
| src-language-features
v & BstFitProj

¥ LoadDataSet

g3 >src-line-fitting end module Mdataset

—— program BstFitProj > _
.cvsignore 1.1 (ASCI ShowDataPoints
v/@ use Mdataset ¥ SquareDistances

» 4

src-modules

@ Make Targets 83 = 0 [2 Problems £  Console Properties

> X 26 errors, 0 warnings, 0 infos

Description Resource

P = org.eclipse.photran-samples

P =Ewhatever2 @ Derived type definition has no components bugl38221.f

bugll18974.f

bugl18961.1[5

€9 FILE tag must be of type CHARACTER

3 lllegal preprocessor directive

PTP Tutorial
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Useful Eclipse Tools

+ Python
+ http://pydev.sourceforge.net

+ Subversion (CVS replacement)
+ http://subclipse.tigris.org
+ Now an Eclipse Technology project

+ ... and many more!

PTP Tutorial
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Future PTP Features

+ Resource manager support for SLURM, PBS,
LSF, BG/P

+ Simplified runtime system interface (plus
support for other MPI runtimes)

+ Debugging support for a broad range of
architectures

+ Full remote project support (combined with
CDT)

+ Remote build and indexing
+ Remote launch/debug

+ Performance analysis tools integration

PTP Tutorial
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PTP Publications

“Developing Scientific Applications Using Eclipse,” Computing
in Science & Engineering, vol. 8, no. 4, July/August 2006, pp.
50-61

+ Link on http://eclipse.org/ptp web page
“A Model-Based Framework for the Integration of Parallel

Tools”, Proceedings of the IEEE International Conference on
Cluster Computing, Barcelona, September 2006

+ Link on http://eclipse.org/ptp web page
IBM developerWorks article:
+ http://www-128.ibm.com/developerworks/edu/os-dw-os-ecl-ptp.html

“An Integrated Tools Platform for Multi-Core Enablement,”

Beth Tibbitts & Evelyn Duesterwald, STMCS: Second
Workshop on Software Tools for Multi-Core Systems, March
2007

+ http://www.isi.edu/~mhall/stmcs07/program.html

PTP Tutorial
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Getting Involved

+ See http://eclipse.org/ptp
+ Read the developer documentation on the wiki

+ Join the mailing lists

+ ptp-dev@eclipse.org; ptp-user@eclipse.org
+ Attend the monthly developer teleconference
+ Attend the annual workshop

+ PTP will only succeed with your participation!

PTP Tutorial
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PTP Tutorial Feedback

+ Please complete feedback form
+ Your feedback is valuable!

Thanks for attending
We hope you found it useful

PTP Tutorial
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